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Preface

About this User's Guide

This user guide is written for system integrators, PC technicians and  
knowledgeable PC users who intend to configure the IPMI settings supported by 
the Nuvoton WPCM450 BMC Controller embedded in Supermicro's motherboards. 
It provides detailed information on how to configure the IPMI settings supported by 
the WPCM450 Controller.

Note: Nuvoton Technology is a subsidiary of Winbond Corp.

User's Guide Organization

Chapter 1 provides an overview on the Nuvoton WPCM450 Controller. It also 
introduces the features and the functionality of IPMI.

Chapter 2 provides detailed instructions on how to configure the IPMI settings 
supported by the WPCM450 Controller.

Chapter 3 provides the answers to frequently asked questions.

Conventions Used in This User's Guide

Pay special attention to the following symbols for proper IPMI configuration. 

Warning: Important information given to avoid IPMI configuration errors and to prevent 
bodily injury.

Note: Additional information given to ensure correct IPMI configuration 
setup.

iii
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Contacting Supermicro

Headquarters
Address: Super Micro Computer, Inc.

980 Rock Ave.
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Tel: +1 (408) 503-8000
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Email: marketing@supermicro.com (General Information)
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's-Hertogenbosch, The Netherlands	

Tel:	 +31 (0) 73-6400390
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Asia-Pacific	
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4F, No. 232-1, Liancheng Rd

New Taipei City 235

Taiwan

Tel:	  +886-(2) 8226-3990

Fax: +886-(2) 8226-3991

Web Site: www.supermicro.com.tw

Technical Support:

Email: support@supermicro.com.tw 

Tel: 	 +886-(2)-8226-3990
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Chapter 1: Introduction

Chapter 1  
 

Introduction

1.1	 Overview of the Nuvoton WPCM450 BMC Controller

The Nuvoton WPCM450, a Baseboard Management Controller (BMC), supports 
PCI-based 2D/VGA Graphics cores via PCI interfaces, multi-media virtualization, 
and Keyboard/Video/Mouse Redirection (KVMR). The WPCM450 Controller is ideal 
for networking management.

The WPCM450 interfaces with the host system via PCI connections to communicate 
with the Graphics core. It supports USB 2.0 and 1.1 for remote KVM emulation. It 
also provides LPC interface support to control Super IO functions. The WPCM450 
is connected to the network via an external Ethernet PHY module or shared NCSI 
connections.

The WPCM450 communicates with onboard components via SMBus interface, PECI 
(Platform Environment Control Interface) buses, and General Purpose I/O ports.

WPCM450 DDR2 Memory Interface
The WPCM450 Controller supports 16-bit DDR2 memory with a speed of up to 220 
MHz. The motherboard supports 128 MB of memory which is shared between the 
BMC and onboard graphics card. For best signal integrity, the WPCM450 provides 
point-to-point connections.

WPCM450 PCI System Interface
The WPCM450 provides 32-bit, 33 MHz 3.3V PCI interface, which is compliant with 
PCI Local Bus Specification Rev. 2.3. The PCI system interface connects to the 
onboard PCI Bridge and is used by the graphics controller. 
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Supermicro IPMI Features
1.	 Remote KVM (graphics) console

2.	 Virtual Media and ISO images

3.	 Remote server power control

4.	 Remote Serial over LAN (text console)

5.	 Event Log support

6.	 Automatic Notification and Alerts (SNMP and email)

7.	 Hardware Monitoring

8.	 Overall health display on the main page

9.	 Out of band management through shared or dedicated LAN

10.	Option to change LAN connection interface at Runtime

11.	 VLAN

12.	RMCP & RMCP+ protocols supported

13.	SMASH/CLP

14.	Secure command line interface (SSH) and Telnet

15.	WSMAN and WS-CIM

16.	RADIUS authentication support

17.	Secure browser interface (Secure socket layer - SSL support)

18.	Lightweight Directory Access Protocol (LDAP) supported

19.	DCMI 1.0 support

20.	Backup and restore the configuration file

21.	Factory defaults from web support

22.	Video quality settings

23.	Record video and play

24.	Server data/information 

25.	Preview of the remote screen on the main page

26.	Update Firmware through browser and OS

27.	OS-independent
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1.2	 WPCM450 Block Diagram

The following diagram represents a typical system setup for the WPCM450 Con-
troller.
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1.3	 Introduction to the IPMI Platform

The Intelligent Platform Management Interface (IPMI) provides remote access to 
multiple users at different locations for networking. It also allows a system admin-
istrator to monitor system health and manage computer events remotely. 

IPMI operates independently from the operating system. When used with an IPMI 
Management utility installed on the motherboard, the WPCM450 BMC Controller will 
connect the South Bridge to other onboard components, providing remote network 
interface via serial links. With the WPCM450 Controller and the IPMI firmware built 
in, the Supermicro motherboard allows the user to access, monitor, diagnose, and 
manage a remote server via Console Redirection. It also provides remote access to 
multiple users from different locations for system maintenance and management.
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1.4 	 Motherboards Supported

This version of X9 SMT IPMI is supported by the motherboards listed in the table 
below. If your motherboard is not included in the table, please refer to the mother-
board product page on our website at www.supermicro.com and download the right 
BMC/IPMI user's guide for your motherboard. 

Intel Dual-Processor Motherboards 
supported (-F models only)

Intel Single-Processor Motherboards sup-
ported (-F models only)

X9DBU-3F/iF X9SCA-F

X9DR3/i-F/LN4F X9SCD-F

X9DRT-HF/HIBFF/HIBQF X9SCi-LN4F

X9DRG-QF/HF/HTF X9SCL-F

X9DAX-iF X9SCL+-F

X9DBL-3F/iF X9SCM-F/IIF

X9DRL-3F/iF X9SRE/I-F

X9DR7-LN4F X9SRW-F

X9DR7-LN4F-JBOD X9SPU-F

X9DRE-LN4F X9SRD-F

X9DR7/E-TF+ X9SRG-F

X9DRD-EF/7LN4F X9SRL-F

X9DRD-iF X9SRH-7F / 7TF

X9DRFF (-7)

X9DRFR

X9DRG-HF/HTF

X9DRH-7F/7TF/iF/iTF

X9DRi-F

X9DRT-F/IBFF/IBQF

X9DRT-HF/HIBFF/HIBQF/

X9SRT-H6F/H6IBFF/H6IBQF

X9DRW-3LN4F+/3TF+/7TPF

X9DRX+-F

X9QR7-TF+

X9QRi-F+

1.5 	 An Important Note to the User

The graphics shown in this user's guide were based on the latest information 
available at the time of publishing of this guide. The IPMI screens shown on your 
computer may or may not look exactly like the screen shown in this user's guide.  
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Chapter 2  
 

Configuring the IPMI Settings

With the Nuvoton WPCM450 BMC Controller and the IPMIView firmware built in, 
Supermicro motherboards allow the user to access, monitor, manage and interface 
with multiple systems in different remote locations. The necessary firmware for ac-
cessing and configuring the IPMI settings are available on Supermicro website at 
http://www.supermicro.com/products/nfo/ipmi.cfm. This section provides detailed 
information on how to configure the IPMI settings. 

2.1	 Configuring BIOS

Before configuring IPMI, follow the instructions below to configure the system BIOS 
settings.

Enabling COM Port for SOL (IPMI)
1.	 Press the <Del> key at bootup to enter the BIOS Setup utility.

2.	 Select Advanced and press <Enter> to enter the Advanced menu.

3.	 From the Advanced menu, select Serial Port Console Redirection and press 
<Enter>. 

4.	 Make sure that the COM port for SOL (COM2 or COM3) is set to enabled. If 
not, select the port for SOL, press <Enter>, and select Enabled. (For IPMI to 
work properly, the BIOS sets console redirection on this port by default.)
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Enabling All Onboard USB ports
1.	 Press the <Del> key at bootup to enter the BIOS Setup utility.

2.	 Select Advanced and press <Enter> to enter the Advanced menu.

3.	 Select Advanced Chipset Configuration and press <Enter>.

4.	 Select South Bridge and press <Enter>. 

5.	 Make sure that all USB ports are enabled (highlighted). If not, Select All USB 
Devices, press <Enter>, and select Enabled to enable all onboard USB ports. 
(This is required for KVM to work properly.)
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Configuring the IPMI Address Using the BIOS                                                                                                                                   
1.	 Press the <Del> key at bootup to enter the BIOS Setup utility.

2.	 Select IPMI and press <Enter> to enter the IPMI menu.

3.	 From the IPMI menu, select BMC Network Configuration and press <Enter>.

4.	 From the BMC Network Configuration submenu, select Configuration Address 
Source and set it to Static to manually set the subnet Mask and Gateway IP 
address. 
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2.2 	 Configuring IP Addresses Using the IPMICFG Utility

1.	 Go to www.supermicro.com/support and click on Supermicro FTP Site (right 
side of the page).

2.	 ACCEPT the license agreement and go to utility > IPMICFG.

3.	 Save a copy of the IPMICFG utility file to a bootable USB flash drive.

4.	 Boot the system into the USB flash drive and run the IPMICFG utility.

5.	 Type IPMICFG and press <Enter> for a list of commands (provided below).

IPMICFG Version 1.02 (Build 120820) Copyright 2012 Super Micro Computer, Inc. 
Usage: IPMICFG Params (Example: IPMICFG -m 192.168.1.123) 

-m Shows IP and MAC

-m IP Sets IP (format: ###.###.###.###)

-a MAC Sets MAC (format: ##:##:##:##:##:##)

-k Shows Subnet Mask

-k Mask Sets Subnet Mask (format: ###.###.###.###)

-dhcp Gets the DHCP status

-dhcp on Enables the DHCP

-dhcp off Disables the DHCP

-g Shows Gateway IP

-g IP Sets Gateway IP (format: ###.###.###.###)

-r BMC cold reset

-garp on Enables the Gratuitous ARP

-garp off Disables the Gratuitous ARP

-fd Resets to the factory defaults

-fde Reset to the facctory default. (Clean FRU & LAN)

-ver Gets the firmware revision

-vlan Gets VLAN status

-vlan on (VLANtag) Enables the VLAN and sets the VLAN tag (If VLAN 
tag is not given, it uses previously saved value.)

-vlan off Disables the VLAN

selftest Checking and reporting on the basic health of 
BMC.

-raw Sends a RAW IPMI request and print the response. 
Format: NetFn LUN Cmd [Data1...DataN]. 

-fru info Shows FRU inventory area info

-fru list Shows all FRU values
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-fru cthelp Shows chassis type code 

-fru help Shows FRU Write help

-fru <Field> Shows FRU field value

-fru <Field> <Value> Writes FRU

-fru backup <File> Backs up FRU to file

-fru restore <File> Restores FRU from file

-fru ver [<V1> <V2>] Retrieves and sets FRU version (V1, V2)

-sel info Shows SEL info

-sel list Shows SEL records

-sel del Deletes all SEL records

-sel raw Show SEL raw data

-sdr Shows SDR records and reading

-sdr del <SDR ID> Deletes SDR record

-sdr ver [<V1><v2>] Retrieves and sets SDR version (V1, V2)

-nm nmsdr Display NM SDR

-nm seltime Get SEL time

-nm deviceid Get ME Device ID

-nm reset Reboots ME

-nm reset2default Force ME reset to Default

-nm updatemode Force ME to Update Mode

-nm selftest Get Self Test Results

-nm listimagesinfo List ME Images information

-nm oemgetpower OEM Power command for ME

-nm oemgettemp OEM Temp. command for ME

-nm pstate Get Max allowed CPU P-State

-nm tstate Get Max allowed CPU T-State

-nm cpumemtemp Get CPU/Memory temperature

-nm hostcpudata Get host CPU data

-nm hostcpudata Get host CPU data

-fan Get Fan Mode

-fan <mode> Set Fan Mode

-pminfo Power supply PMBus health

-psfruinfo Power supply FRU health

-user list List user privilege information

-user help Show user privilege code

-user del <user id> Delete user

-user level Modify user privilege
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2.3	 Connecting to the Remote Server

Using the IPMIView to Connect to the Remote Server
1.	 Connect a LAN cable to the onboard LAN1 port or the dedicated IPMI LAN 

port.

2.	 Choose a computer that is connected to the same network and open the 
IPMIView utility.

3.	 Go to File > New > System. Enter the System Name, IP Address of IPMI/
BMC, and the Description in the appropriate fields, and press <Enter>.

4.	 Select the system from the IPMI Domain. Enter the Login ID and Password 
in the appropriate fields to log in to the IPMIView utility. The default ID and 
password is ADMIN / ADMIN.

Using the Browser to Connect to the Remote Server
1.	 Connect a LAN cable to the onboard LAN1 port or the IPMI LAN port.

2.	 Choose a computer that is connected to the same network and open the 
browser.

3.	 Enter the IPMI/BMC IP address of each server that you want to connect to in 
the address bar of your browser.

4.	 Once the connection is made, the Login screen as shown on the next page 
will display.

Notes: 

1. The default network setting is "Failover", which will allow the IPMI to 
connect to the network through a shared LAN port (first onboard LAN port) 
or through the IPMI Dedicated LAN Port. If the IPMI must be connected 
through a specific port, please change the LAN configuration setting under 
the Network Settings.

2. For IPMI to work properly, enable all onboard USB ports and the COM 
port designated for SOL (IPMI) on the motherboard. All USB ports and the 
COM port for IPMI are set to Enabled in the system BIOS by default. Refer 
to Section 2.1 Configuring BIOS for more information.
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2.4 	 Accessing the Remote Server Using the Browser

To Log In to the IPMI Web GUI
Once you are connected to the remote server's web GUI with a browser, the follow-
ing IPMI Login screen will display.

1.	 Enter your Username in the Username fields.

Note: The manufacturer default username and password are ADMIN/ADMIN. 
Once you have logged into the BMC using the manufacturer default password, 
be sure to change your password for security purpose. 

2.	 Enter your Password in the Password box and click <Login>.

3.	 The Home Page will display as shown on the next page.
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2.5 	 IPMI Main Screen

The IPMI Main screen displays the following information.

The IPMI Main screen displays system information, including the following:

1.	 Menu Bar: The menu bar on the top displays System, Server Health, Configu-
ration, Remote Control, Virtual Media, Maintenance, and Miscellaneous. Click 
an item on the Menu Bar to access an IPMI feature and configure its settings.

2.	 Submenu: This window displays IPMI submenu items. Click an item in this 
window to configure the setting.

3.	 Main Display Area: This area displays the contents of the particular section. 
Click an item in this area to configure the setting.

4.	 System Health Status: This icon displays the health status of the server.

•	Green: Indicates that the server is normal.

•	Orange: At least one alert has occurred. Take proper actions to ensure 
system health.

•	Red: At least one critical condition has occurred. Immediate attention is 
required to resolve the critical condition for the server to function normally.

5.	 Language Select: From the pull-down menu, select a language. 

•	English

•	Japanese

1

2

3

4 5
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2.6 	 System

The Summary screen (shown below) is displayed when you first log into the remote 
server. From this location, you can view system information or FRU information.

System Information: This submenu displays the following firmware information.

•	Firmware Revision 

•	Firmware Build Time

•	IP Address

•	BMC MAC Address and System LAN MAC addresses

•	Preview Screen: This feature allows the user to launch the remote console 
by clicking on the preview screen

•	Power Control: Select from a limited set of power control functions.

FRU Reading: Click this submenu to display the following BMC FRU (Field Re-
placeable Unit) information. You can also configure the FRU settings by using the 
Supermicro IPMIView or ipmicfg utility.

•	FRU Device ID

•	Chassis Information

•	Board Information

•	Product Information
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2.7 	 Server Health

This feature allows you to view sensor readings and event logs. Click Server Health 
in the main menu to display the screen shown below.

The following submenu items are available under Server Health:

1.	 Sensor Readings: Click this submenu to view sensor information (see 
next page).

2.	 Event Log: Click this submenu to access event logs.
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2.7.1 Sensor Readings
This page displays sensor readings for the remote console.

1.	 From the pull-down menu, select a sensor type (category). The options 
include the following.

•	All Sensors

•	Temperature Sensors

•	Voltage Sensors

•	Fan Sensors

•	Physical Security/(Chassis Intrusion)

•	Power Supply

2.	 The color displayed in front of a sensor indicates the status of the sensor.

•	Green: Indicates that the sensor reading is normal and the system is func-
tioning normally.

•	Amber: Indicates that there is an alert. Attention is needed to ensure that 
the system is functioning properly.

•	Red: Indicates that one or more sensors have reached the critical state. 
Immediate action is needed to resolve the problem.

1

2

3 4 5

6 7
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3.	 Name of the Sensor: This column displays the names of the sensors that are 
currently active.

4.	 Status: This column indicates the status of each sensor reading.

5.	 Reading: This column indicates the reading of each sensor.

6.	 Refresh: Click this item to refresh the page.

7.	 Show Thresholds: Click this item to display sensor thresholds.
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2.7.2 Event Log
This page displays a record of critical system monitoring events. The event log 
indicates the time when a critical condition had occurred and when this condition 
was resolved. You can choose a specific event category from the pull-down menu 
to display events included in this category. 

1.	 Event Category: From the pull-down menu, select an event category to 
display.

•	Sensor-Specific Events: These event logs are generated by the BMC if the 
sensor's reading reaches the threshold.

•	BIOS-Generated Events: These event logs are generated by the BIOS and 
logged to the BMC.

•	System Management Software Events: These events logs are generated by the 
OS, application software, etc., and logged to the BMC.

•	All Events: This category includes all the above event logs.

1
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2.8 	 Configuration

This feature allows you to configure various network settings. Click the Configuration 
button in the menu bar to display the following screen.

In addition to the events listed on the previous page, it is normal to see boot-up 
and shutdown events generated by the installed system software (OS). The table 
below lists examples of these types of events.

Sensor Type Event
OS Boot A: boot completed

C: boot completed

PXE boot completed

Diagnostic boot completed

CD-ROM boot completed

ROM boot completed

Boot completed - boot device not specified

OS Stop/Shut-

down

Stop during OS load/initialization, Unexpected error dur-

ing system startup, Stopped waiting for input or power 

cycle/reset

Run-time stop (a.k.a 'core dump', 'blue screen')

OS graceful stop (system powered up, but normal OS 

operation has shut down and system is awaiting reset 

pushbutton, power cycle or other external input)
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This section allows you to configure the following settings:

•	Alerts: Use this item to configure alert destination settings.

•	Date & Time

•	LDAP: Use this item to configure LDAP (Lightweight Directory Access Protocol) 
settings for authentication and access to the LDAP server.

•	Active Directory: Use this item to configure the settings for authentication and 
access to the Active Directory server.

•	Radius: Use this item to configure the settings for authentication and access 
to the Radius server.

•	Mouse mode

•	Network

•	Dynamic DNS

•	Remote Session

•	SMTP

•	SSL Certificate

•	Users

•	Port

•	IP Access Control

•	Fan Mode
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2.8.1 Configuring the Alerts Settings
This feature allows the user to configure alert settings. When you click Alerts in the 
Configuration submenu, the following screen displays

To modify an existing alert setting, do the following (refer to above image):

1.	 Click Alerts to activate the alert submenu.

2.	 Click Modify to configure or modify the settings of an alert. 

3.	 Click Send Test Alert to check if the alerts have been set and sent out cor-
rectly. 

4.	 Click Delete to delete an alert.

Creating an Alert

2 3 4

2
3
4
5
6
7

1

1
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Follow the steps below to setup an alert (refer to the image at bottom of page 2-16):

1. Select Alerts from the window on the left.

2. Select the event severity level from the pull-down list.

3. Enter the SNMP Trap receiver (i.e. IPMI View) IP address to use SNMP. For 
further guidance on typical inquiries relating to SNMP, see the table below.

Item Answer
SNMP version number SNMP version 2.

MIB community name A community name is not required since 
SNMP version 2 only uses traps.

MIB file location Go to http://www.supermicro.com/products/
nfo/IPMI.cfm and click “IPMI MIB (SMT)” 
(right-hand side of the page).

The IPMI item you need to  con-
figure so the SNMP manager 
can receive the SNMP trap

The alert LAN destination address (see #4 
under 2.4.1) must be set to the same IP in 
as the SNMP manager.

Can I query for detailed infor-
mation on the MIB "Event" trap 
items?

Detailed queries are not possible because 
event mapping is based only on sensor 
type, event type, and sensor offset.

A list of trap items generated for 
my platform

No standard list of event traps exist be-
cause the PEF (Platform Event Filter) table 
is OEM customizable.

4. Enter the email address to send the alert to, then configure the SMTP settings 
(see section 2.8.10)

5. Enter the subject line of the alert.

6. Enter a message for the alert.

7. Click Save to save the settings.
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2.8.2 Configuring Date and Time Settings
This feature allows you to configure the time and date settings for the host server 
and the client computer. In the Configuration submenu, select Date and Time to 
display the screen shown below.

You can either set the date and time manually or use the NTP server to set date 
and time. Follow the instructions below to set date and time settings.

Note: Time zone is enabled when NTP Enable is selected. The options 
are UTC -12:00 hr. ~ +12:00 hr. 

1.	 Click Date and Time on the left to set the date and time settings.

2.	 Select the time zone (available if NTP is enabled).

3.	 Check this item to use NTP settings.

4.	 Enter the IP address for the primary NTP server.

5.	 Enter the IP address for the secondary NTP server.

6.	 Enter the date.

7.	 Enter the time in hh/mm/ss format.

8.	 Check this box for the time to automatically adjust during daylight savng time.

Click Refresh to change the date/time settings.

Click Save to save the entries.

1

2
3
4
5
6
7
8
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2.8.3 Configuring LDAP (Light-Weight Directory Access 
Protocol) Settings

This feature allows you to configure the LDAP settings. In the Configuration sub-
menu, select LDAP to display the screen shown below.

Follow the steps below to configure the LDAP settings.

1.	 Check the enable box to enable LDAP Authentication or LDAP Authentication 
over SSL support. 

2.	 Enter a port number of the LDAP server. 

3.	 Enter an IP Address of the LDAP server. 

4.	 Enter a Bind Password of the LDAP server.

5.	 Enter a Bind DN value in the field. The bind DN is the user or the LDAP 
server that is permitted to do search in the LDAP directory within a defined 
search base. 

6.	 Enter a Searchbase value in the field. The Searchbase is the directory that 
allows the external user to search data.

7.	 After entering the information in the fields, click Save to save the settings. 

1

2

4
5

6

7
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2.8.4 Active Directory Settings
This page displays a list of role groups and their Group IDs, Group Names, Domains 
and Network Privilege settings. In the Configuration submenu, select Active Direc-
tory to display the screen shown below.

1.	 To enable or configure the Active Directory server, click the here hyperlink 
(see next page for instructions on enabling or configuring the Active Direc-
tory).

2.	 Select a group and click Add to add a role group. 

3.	 Select a group and click Modify to modify a role group. 

4.	 Select a group and click Delete to delete a role group.

1

2 3 4
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Configuring the Active Directory Settings

This feature allows the user to configure the Advanced Active Directory settings. 
Click the here hyperlink (see #1 on previous page) display the Advanced Settings 
page for the active directory (shown below).

1.	 Check the Enable box to enable Active Directory authentication support. Once 
enabled, you can enter values in the fields below. 

2.	 Enter User Domain Name in the field. 

3.	 Enter Time Out value in the field to set the time limit for a user to stay 
logged-in. 

4.	 Enter Controller Server Address1. 

5.	 Enter Controller Server Address2. 

6.	 Enter Controller Server Address3. 

After entering the information, click Save to save the settings.

1
2

4
5

6
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2.8.5 Configuring the RADIUS Settings
This feature allows you to configure RADIUS settings. In the Configuration sub-
menu, select RADIUS to display the screen shown below.

1.	 Check the Enable box to enable RADIUS support. Enter the information in the 
fields below to configure RADIUS settings. 

2.	 Enter the port number of the RADIUS server. 

3.	 Enter the IP address of the RADIUS server. 

4.	 Enter a (secret) password for the user to access the RADIUS server

After entering the information in the fields, click Save to save the information. 

1
2

4
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2.8.6 Configuring the Mouse Mode Settings
This feature allows you to configure the mouse mode settings. In the Configuration 
submenu, select Mouse Mode to display the screen shown below.

1.	 This item displays the current Mouse Mode setting. To select a proper mouse 
mode setting, click the proper radio button as shown below.

•	Set the mouse mode to Absolute for the Windows OS. (This is the default 
setting.)

•	Set the mouse mode to Relative for the Linux/Unix OS. 

•	Set the mouse mode to Single for use with LSI's WebBIOS GUI.

After entering the information, click Save to save the settings.

Note: IPMI is an OS-independent platform, and IKVM support is an added 
feature for IPMI. For your mouse to function properly, please configure 
the Mouse Mode settings (see above) according to the type of OS used 
in your machine.

1
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Enter information into the following fields to configure network settings:

1.	 MAC Address: This field displays the MAC address for the network server. 

2.	 Host Name: Enter a hostname for the network server (optional).

3.	 Check the first radio button to obtain an IP address automatically by using 
DHCP (Dynamic Host Configuration Protocol) or check the second radio but-
ton to setup the IP address by manually entering the information in the fields 
below. (Note: DHCP is the default setting.)

4.	 IPv4 and IPv6 Setting: To set the IP address manually using the IPv4 or 
IPV6 format, enter proper information in the available fields. 

2.8.7 Configuring Network Settings
This feature allows you to configure the network settings. In the Configuration 
submenu, select Network to display the screen shown below.

8
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5.	 VLAN: Check this box to enable Virtual LAN support, and enter the VLAN ID 
in the field.

6.	 Lan Interface: This feature allows the user to select the port to be used for 
IPMI out-of-band communication. 

•	The default setting is Failover, which will allow IPMI to be connected from either 
the shared LAN port (LAN1/0) or the dedicated IPMI LAN port. Precedence is 
given to the Dedicated LAN port over the shared LAN port.

•	Select <Dedicated LAN> for IPMI to connect through the IPMI Dedicated LAN 
port at all time.

•	Select Shared LAN for IPMI to connect through the first LAN port (port 0 or 
port1) on the board.

7.	 RMCP Port: This feature allows the user to select the desired RMCP (Re-
mote Mail Checking Protocol) port based on his configuration. The default 
port is 623. 

8.	 Network Link Status: This section displays the status, speed, and duplex 
type for the dedicated and shared network links.

After entering all fields above, click Save to save the Network settings.
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2.8.8 Configuring Dynamic DNS (Domain Name System) 
Settings

This feature allows you to configure Dynamic DNS settings. In the Configuration 
submenu, select Dynamic DNS to display the screen shown below.

1.	 Select the desired radio button to enable or disable Dynamic DNS update 
support. The default setting is disabled.

2.	 Enter the IP address of your Dynamic DNS server. 

3.	 Enter the name of the BMC (Baseboard Management Controller) Host Server.

4.	 Check the box to enable TSIG Authentication support, and browse the files to 
select the TSIG.key file. (This item is optional.)

5.	 Browse the files to select the TSIG.private file. (This item is optional.)

After entering the required information in the fields, click Save to save the informa-
tion you have entered. 

4

5

1
2
3



Chapter 2: Configuring BMC/IPMI Settings

2-27

2.8.9 Configuring the Remote Session Settings
This feature allows you to enable or disable encryption support on IKVM, or to 
select the Virtual Media Attach mode for console redirection. In the Configuration 
submenu, select Remote Session to display the screen shown below.

1.	 This item displays the current Virtual Media Attached mode. To change the 
Virtual Media Attached mode, select the desired setting from the list below.

•	Auto Attach (Default): Select this mode to automatically enable virtual media 
support and make it available for remote access. Virtual devices will only be 
shown in the operating systems and the BIOS when a device or an ISO image 
is connected through the virtual media wizard.

•	Attach: Select this mode to activate a virtual media and make it available for 
remote access. A virtual device will always be seen in the system BIOS even 
when it is not active.

•	Detach: Select this mode to disable virtual media for remote access.

After making selection, click Save to save the settings.

1
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2.8.10 Configuring the SMTP Settings
This feature allows you to configure SMTP (Simple Mail Transfer Protocol) settings 
for email transmission through the network. In the Configuration submenu, select 
SMTP to display the screen shown below.

To configure SMTP settings, follow the instructions below.

1.	 Check the box to enable SMTP SSL Authentication support. Once SMTP SSL 
Authentication is enabled, enter information in the fields below. 

Note: SHA2 and RSA 2048 bit SSL supported.

2.	 Enter the IP address for the SMTP (Simple Mail Transfer Protocol) Mail 
server. The SMTP port number will be displayed.

3.	 Enter the user name for your SMTP Mail server (optional).

4.	 Enter the user password for your SMTP Mail server (optional). The status of 
the sender's address will be displayed.

After entering the information above, click Save to save the settings.

4
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2.8.11 Configuring the SSL (Secure Sockets Layer) 
Certification

This feature displays the default certificate and private keys. It also allows you to 
upload a new SSL certificate.  In the Configuration submenu, select SSL to display 
the screen shown below.

1
2

3

1.	 To enter a new SSL Certificate, enter a new certificate in the field. You can 
also browse the data base to select a new certificate.

Note: SHA2 and RSA 2048 bit SSL supported.

2.	 Enter a new Private Key in the field, if desired. You can also browse the data 
base to select a new key. 

3.	 After entering the new SSL certificate and/or a new private key, click Upload 
to upload the certificate and private key to the server.



2-30

	  X9 SMT IPMI User's Guide

3

2.8.12 Configuring Users Settings
This page displays information on the current users. It also allows you to add, delete  
or modify user information. In the Configuration submenu, select Users to display 
the screen shown below. 

1.	 This item lists current user information, including User ID, User name and 
Network Privilege settings. Network privilege settings are shown below. A 
maximum of 10 user profiles can be made.

4

1

2

Function  User  Operator  Administrator
System Information  Full Access  Full Access Full Access 

Chassis Locator Control  View Only  Full Access Full Access 
FRU Reading  Full Access  Full Access Full Access 
Sensor Readings  Full Access  Full Access Full Access 
Event Log  View Only  Full Access Full Access 
Alert  No  View Only  Full Access 
LDAP  No  View Only  Full Access 
Mouse Mode  No  Full Access Full Access 
Network  No   View Only  Full Access 
Remote Session  No   View Only  Full Access 
SMTP  No   View Only  Full Access 
SSL  No   View Only  Full Access 
Users  No   View Only  Full Access 
Event Action  No   View Only  Full Access 
Power Control  View Only   Full Access Full Access 
KVM  View Only   Full Access Full Access 
F/W Update  View Only   View Only   Full Access 
SDR Update  View Only   View Only   Full Access 
Logout  Full Access  Full Access Full Access 
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2.	 To add a new user to the network, click Add User. When prompted, select an 
empty slot from the users list to add an user.

3.	 To modify the information or the status of a user, click Modify User. When 
prompted, using the arrow keys, select a user from the users list to modify 
the user information.

4.	 To delete a user from the network, click Delete User. When prompted, using 
the arrow keys, select a user from the users list to delete it from the list.

Note: The User ID #1 (Anonymous) account cannot be deleted.
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2.8.13 Configuring Port Settings
This page allows you to configure port settings. In the Configuration submenu, select 
Port to display the page as shown below. 

1.	 Web Port: Enter the desired web port number.

2.	 Web SSL Port: Enter the Web SSL port number.

3.	 IKVM Port: Enter the desired IKVM port number.

4.	 Virtual Media Port: Enter the desired virtual media port number.

After configuring the port settings, click Save to save the settings.

4
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2.8.14 IP Access Control
This page displays an IP Access Control table, which will allow you to add, modify 
and delete an IP Access rule, an IP Address/Mask setting or an IP access policy. 

Note: This submenu is applicable to X9 motherboards only. 

1.	 Check this box to configure IP Access Control settings. (The default setting is 
Accept.)

2.	 Rule Number: This column lists the number of IP Access Control rules.

3.	 IP Address/Mask: This column displays IP Address/Mask settings.

4.	 Policy: This column displays the status of an IP Access policy.

5.	 Number of Access Rules: This displays the maximum number of IP Access 
rules you can set for the system.

4

1
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Modifying IP Access Rules

Select an item in the IP Access Control list and click Modify, to display the Add 
Rule screen as shown below.

To modify a rule, enter the information needed for the following items:

•	IP Address/Mask: This item allows you to grant access to a specific IP address or 
a range of IP addresses. For example, if you wanted to specify a range of IP ad-
dresses from 192.168.0.1 to 192.168.0.126, you would enter 192.168.0.1/25.

•	Policy: Select Accept to allow access for the IP address(es) entered above. 
Select Drop to deny access.
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2.8.15 Configuring Fan Settings
This page allows you to configure fan mode settings. In the Configuration submenu, 
select Fan Mode to display the screen shon below.

1.	 This item displays the current fan mode setting.

2.	 Check this radio button to use the standard fan speed setting for power-
saving.

3.	 Check this button to use the full speed setting for optimal system perfor-
mance.

4.	 Check this button to use the optimal fan speed setting which will adjust the 
fan speed by balancing the needs between system performance and power 
saving.

Note: Fan mode settings will vary depending on the server board.

After configuring the fan speed setting, click Save to save the entry.

4
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2.9 	 Remote Control 

This section allows you to carry out activities and perform operations on a  remote 
server via remote access.

To launch remote console or to change the power settings of the remote console, 
follow the instructions below.

1.	 Click Console Redirection to launch console redirection and configure the 
settings of the remote server. For more details on console redirection, refer to 
section 2.9.1 (next page).

2.	 Click Power Control to display and execute the power options of the remote 
system, including the following:

•	Reset Server

•	Power Off Server-Immediately

•	Power Off Server-Orderly Shutdown

•	Power On Server

•	Power Cycle Server

3.	 Click Launch SOL to launch SOL (Serial Over LAN) console and manage the 
remote server.

2
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2.9.1 Launching Console Redirection
This feature allows you to launch console redirection via IKVM (keyboard, video/
monitor, mouse) support. In the Remote submenu, select Console Redirection to 
display the screen shown below.

1.	 Click Launch Console on the Console Redirection screen to launch the 
remote console via Java or Active X (for the Internet Explorer). If it is blocked 
by the IE due to security reasons, click on the top of the menu bar and select 
Download File. 

2.	 A screen will display to indicate that Java is launching. 

3.	 When the warning screen displays (as shown above), click Run to launch the 
remote console.

1
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2.9.1.1 Console Redirection > Virtual Media
This feature allows you to configure virtual device settings for your console redirec-
tion. In the iKVM menu bar, select Virtual Media to display the submenu items as 
shown below. 

1.	 Click Virtual Storage to open the window shown below. Use the Virtual Stor-
age window to select a device you want to connect to the remote server as a 
virtual device.

You can connect Floppy, USB Flash, CD-ROM, DVD ROM or ISO images using 
this feature.

1
2

2.	 Click Virtual Keyboard to use the onscreen Keyboard shown below. Click a 
key on the keyboard for your BMC connection.
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1.	 Click Start to start video recording from your remote server.

2.	 Click Stop to stop video recording from your remote server. 

Note: By default, recording will stop automatically after two minutes. You 
can change this through the Display Preferences (see section 2.9.1.5.2)

2.9.1.2. Console Redirection > Record
This feature allows you to record media displays for your console redirection. In 
the iKVM menu bar, select Record to disply the submenu items as shown below. 

1
2
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1.	 In the iKVM menu bar, click Record to display the recording options, then 
click Start to start recording. 

2.	 From the pop-up window, select the location where you want to save the 
recording.

3.	 Enter the filename and click Save to save the recording.

2.9.1.3. Console Redirection > Recording Media
This feature allows you to record the media displays. Follow the instructions below 
to start and stop media recording. 

1

2
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2.9.1.4. Console Redirection > Macro
This feature allows you to configure macro settings for your console redirection. 
In the iKVM menu, select Macro to display the submenu items as shown below. 

The submenu items include the following.

•	Hold Right ALT Key: This item performs the same function as holding down 
the <Right Alt> key.

•	Hold Left ALT Key: This item performs the same function as holding down 
the <Left Alt> key.

•	Right Windows Key: This item performs the same function as pressing the 
<Right Windows> key. Right click this item to select <Hold Down> or <Press & 
Release> for the Right Windows key.

•	Left Windows Key: This item performs the same function as pressing the 
<Left Windows> key. Right click this item to select <Press Down> or <Press & 
Release> for the <Left Windows> key.

•	Macro: Click this item to activate the macro hotkey submenu as shown below. 
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2.9.1.5 Console Redirection > Options
This feature allows you to configure options settings for your console redirection. In 
the iKVM menu bar, select Options to display the submenu items as shown below. 

The options menu allows you to configure the following settings:

•	Hotkey

•	Preference 

•	Full-Screen Mode

•	OSD UI Style  

•	Keyboard Mouse Hotplug 
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2.9.1.5.1 Console Redirection > Options > Hotkey Settings
This feature allows you to configure Hotkey settings for your console redirection. 
In the Options submenu, select Hotkey Settings to open the hotkey window as 
shown below. 

41

2
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To assign a hotkey for an action, follow the steps below.

1.	 Click Start.

2.	 Enter the hotkey of your choice (it can be a single word or a combination).

3.	 Click Stop. 

4.	 Select an item from the action list and click Assign.

5.	 Click Close to exit.

6.	 Click Default to reset all hotkey settings to default values.

6
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2.9.1.5.2. Console Redirection > Options > Preference > Display
This feature allows you to configure Video Recording Preference settings for your 
console redirection. In the iKVM menu, select Preference to open the preference 
window as shown below. 

To configure the preference settings for video recording, follow the instructions 
below.

1.	 Click the Display tab to configure video display features. 

2.	 Check this box to enable auto stop support, which will allow the video record-
ing to be automatically turned off after recording of certain period of time. If 
enabled, enter the number of minutes upon which your video recording will 
automatically stop recording.

3.	 Use the slider on the Display Scale to set the appropriate scale setting for 
your video display from Low (25) to High (100).

4.	 To ensure the best image quality, select High Color for heavier network traffic 
connections; select Low Color for lighter network traffic.

5.	 Click OK to save the recording preference settings or click Cancel to cancel 
the selection. 

4
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To configure Video Input settings, follow the instructions below.

1.	 Click the Input tab to configure mouse and keyboard settings. 

2.	 Check Enable Mouse Input to enable mouse support so that you can use 
the mouse as an input device. Once mouse support is enabled, set a proper 
mode for your console redirection. 

•	Select Absolute Mode for the Windows OS, Ubuntu, or RHEL 6.x and later.

•	Select Relative Mouse for the Linux OS. 

•	Select Single Mouse for use with all other OS.

3.	 Select Enable Keyboard Input to enable keyboard support so that you can 
use soft keyboard as an input device. From the Keyboard layout pull-down 
menu, select the right language setting for your soft keyboard. 

4.	 Use the slider on the Repeat Key Timeout scale to select the appropriate 
timeout settings for repeat keystrokes from 0ms to 1000ms (micro-second).

5.	 Click Save to save the keyboard setting or click Cancel to cancel it.

2.9.1.5.3. Console Redirection > Options> Preference >Input
This feature allows you to configure Video Recording input settings for your con-
sole redirection. In the iKVM menu bar, select Preferences to open the preference 
window as shown below.
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To select the correct language setting for your console, follow the steps below.

1.	 Click the Language Setting tab.

2.	 From the Language Setting pull-down menu, select the language you want 
to use for your console redirection. The language options include English, 
Japanese, German, French, Spanish, Korean, and Italian.

3.	 Once you have selected a language setting, click OK to use the language. 

2.9.1.5.4. Console Redirection > Options > Preference > 
Language Settings

This feature allows you to configure language settings for your console redirec-
tion. In the iKVM menu bar, select Preferences to open the preference window as 
shown below.

1
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2.9.1.5.5. Console Redirection > Options > Preference > Window 
This feature allows you to configure window settings for your console redirection. In 
the iKVM menu bar, select Preferences to open the preference window as shown 
below. 

To select the correct window settings for your console redirection, follow the instruc-
tions below.

1.	 Click the Window tab.

2.	 Check Auto re-size window for the system to reset the size of your display 
window. (If you do not wish your display window to be re-sized automatically, 
leave the box unchecked.)

3.	 Click OK to save the window settings. 

1
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2.9.1.5.6. Console Redirection > Options > Preference > Video 
Stream Control 

This feature allows you to configure video stream settings for your console redirec-
tion. In the iKVM menu bar, select Preferences to open the preference window as 
shown below. 

To select the correct video stream control settings for your console redirection, 
follow the instructions below.

1.	 Click the Video Stream Control tab.

2.	 Check Enable Flow Control to provide support for video flow control. Once the 
Flow Control support is enabled, select the proper speed for video streaming 
from the pull-down menu. The speed settings listed below.

•	256K Cable/DSL

•	T1

•	T2

3.	 Click OK to save the Video Stream Control setting. 

1
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2.9.1.5.7. Console Redirection > Options > Full Screen Mode
This feature allows you to configure the screen settings for your console redirection. 
To set a full screen display for your console redirection, follow the instructions below.

1.	 Select Options from the iKVM menu bar to display the submenu.

2.	 Select Full Screen Mode from the submenu. A full-screen display will appear.

4
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3.	 To leave the full screen display, click Options in the iKVM submenu.

4.	 From the submenu, select Leave Full Screen and press <Enter>.
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2.9.1.5.8 Console Redirection > Options > OSD UI Style
This feature allows you to configure OSD (On-screen Display) UI (User-Interface) 
Style settings for your console redirection. To configure the OSD UI settings, follow 
the steps below.

1.	  From the Options submenu, select OSD UI Style to display the OSD UI Style 
screen as shown below. This screen provides shortcuts to the main features 
provided by the firmware for your console redirection. 

2.	 Click an OSD UI Style icon to change the settings listed on the next page. 

The OSD UI Style Screen Close-up

1

2
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1.	 Move OSD UI Screen: Click this icon to move the OSD UI Screen to a new 
location on the display.

2.	 Hotkey Settings: Click this icon to access the Hotkeys submenu and change 
the settings.

3.	 Virtual Media: Click this item to access the Virtual Media submenu and 
configure the settings.

4.	 Virtual Keyboard: Click this item to access the Virtual Keyboard submenu 
and use your virtual (soft) keyboard.

5.	 Preferences submenu: Click this item to access the References submenu 
as indicated in the previous sections.

6.	 Full Screen Mode: Click this item to change the size of your display window 
to the full screen mode.

7.	 Exit Remote Console: Click this item to exit from the remote connection.

8.	 Users List: Click this item to display the user list.

9.	 Change Toolbar Display: Click this item to change the toolbar display 
format.

10.	Hotplug Keyboard/Mouse: Click this item to hotplug keyboard and mouse.

11.	Macro: Click this item to enable Macro support and use Macro features.

12.	Video Recording: Click this item to access the Video Recording submenu 
and to use video recording.

13.	Image Size: This item displays the image size in pixel.

14.	IP Address: This item displays the IP Address of IPMI.

The OSD UI Style Screen Close-up

6 8 9741 2 3 5 10 11 12
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2.9.1.5.9 Console Redirection > Keyboard Mouse Hotplug 

1.	 in the iKVM menu, select Options to display the submenu. 

2.	 Click Keyboard Mouse Hotplug from the pull-down menu to simulate a key-
board/mouse hotplug on the remote console.

1

2
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2.9.1.6 Console Redirection > User List
This feature allows you to access the user list. To configure user list settings, follow 
the instructions below.

1.	 From the iKVM menu bar, click User List to display the screen shown above.

2.	 Session ID: This item displays the current session ID#.

3.	 User Name: This item displays the name(s) of the user(s).

4.	 IP Address: This item displays the IP Address of the client server.

4

1

2 3
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2.9.1.7 Console Redirection > Capture
This feature allows you to capture the screen displayed on your remote console.

In the iKVM menu, click Capture > Full Screen View as shown below.

2.9.1.8 Console Redirection > Power Control
Use this feature to perform power functions using the remote console. In the iKVM 
menu, select Power Control to display the options as shown below.

The options in the Power Control submenu are described below.

•	Set Power On: Powers on the server.

•	Set Power Off: Powers off the server immediately.

•	Software Shutdown: Powers off the server after OS shutdown functions have 
completed

•	Set Power Reset: Reboots the server without powering off.

2.9.1.9 Console Redirection > Exit

To exit from Console Redirection, select Exit.  At the prompt "Are you sure?", click 
Yes to exit from remote redirection or click No to return to the current session.
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2.9.2 Remote Control - Server Power Control
This feature allows you to check the power state and perform remote power control.

Select from the following power options:

•	Reset Server: Select this optoin to reset the server.

•	Power Off Server - Immediate: Select this option to shut down the server im-
mediately.

•	Power Off Server - Orderly Shutdown: Select this option to shut down the server 
after OS shutdown functions have completed.

•	Power On Server: Select this option to power on the server. This option is only 
available if the server is not currently powered on .

•	Power Cycle Server: Select this option to simulate an AC power cycle. The 
server will power off, then power on after a couple seconds.

Note: Power cycling the server via IPMI is not the same as an actual power 
cycle. Stanby power is still available.
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2.9.3 Remote Control > Launch SOL
This feature allows you to launch the remote console by using SOL (Serial over 
LAN). This feature provides serial port connections over LAN to provide access 
to a host server via Console Redirection. It also allows a system administrator 
to monitor and manage a server from a remote site. To launch SOL, follow the 
instructions below.

1.	 In the Remote Control submenu, select Launch SOL to display the screen 
shown above.

2.	 Click Launch SOL to launch SOL. After SOL is launched, the following 
screen displays.

1
2
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Select a Baud Rate (bps) from the pull-down menu as your SOL transfer rate. The 
options are listed below. Make sure that the Baud Rate selected here matches the 
Baud Rate set in the BIOS. 

•	9600 bps (bit-per-second) 

•	19200 bps

•	38400 bps 

•	57600 bps

•	115200 bps 

After selecting the Baud rate, click Start to start the session. Once a session has 
started, click Stop at any time to stop SOL connection.
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2.10 	 Virtual Media

This feature allows you to upload and share images via the BMC (Baseboard 
Management Controller). These images will be emulated to the host server as USB 
applications. To configure the Virtual Media settings, follow the instructions below.

1.	 Select Virtual Media to configure virtual media settings for your remote con-
sole, including Floppy Disk and CD-ROM image settings.

2.	 Select Floppy Disk to configure the floppy disk settings for your console 
redirection. 

3.	 Select CD-ROM Image to configure CD-ROM image settings for your console 
redirection. 

1

2
3
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2.10.1 Configuring USB Floppy & Flash Device Settings
To configure USB floppy and flash device settings, follow the instructions below.

4.	 USB Floppy & Flash Status displays the status of a USB floppy or a flash 
device.

5.	 CDROM & ISO Status displays the status of a CDROM or an ISO device.

6.	 Click Refresh Status to refresh the USB floppy or the flash device. 

7.	 Click Browse to select an image file from your file system for your console 
redirection. 

8.	 After you've selected your image file, click Upload to upload your image file 
to the server.

6

8
7

4
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2.10.2 Configuring CD ROM Image File Settings
To configure CD ROM image files for sharing, follow the instructions below.

9.	 In the Virtual Media submenu, select CD-ROM Image to display the screen 
shown above.

•	USB Floppy & Flash Status indicates the status of a USB floppy or a flash 
device.

•	CD ROM & ISO Status indicates the status of a CD-ROM or an ISO device.

10.	Click Refresh Status to refresh USB Floppy/Flash and CD ROM/ISO devices. 

11.	Enter the Share host server for your console redirection. 

12.	Enter the path to the CD-ROM image file for sharing.

13.	Specify the user that has access to the CD-ROM image files. (This item is 
optional).

14.	Enter your user password (optional). 

15.	To mount or unmount an image file, click Mount or Unmount, then click the 
Save button.

9
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2.11 	Maintenance

Use this feature to manage and configure IPMI device settings. 

Select Maintenance in the menu bar to display the maintenance main screen as 
shown above. The Maintenance menu includes the following items.

•	Firmware Update: Click this item to update the remote server's BMC firmware. 
The Firmware Update screen is shown in the next section.

•	Unit Reset: Click this item to reboot the BMC (IPMI) controller. 

•	IKVM Reset: Click this item to reset the IKVM setting. 

•	Factory Default: Click this item to restore IPMI to the factory default settings. 

•	IPMI Configuration: Click this item to save IPMI configuration settings to a file 
or to load IPMI configuration settings from a file. 

•	System Event Log: Click this item to view the system event logs.
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2.11.1 Maintenance > Firmware Update

Firmware Update

To update IPMI Firmware, follow the instructions below.

1.	 In the Maintenance submenu, select Firmware Update.

2.	 Click Enter Update Mode to enter the update mode. A warning message will 
display.

Warning: Once the server is in the firmware update mode, the device will be reset, 
and the server will reboot even if you cancel firmware updating.

3.	 Click OK to update your IPMI firmware. Once you've clicked OK to update 
the firmware, the Firmware Upload screen will display as shown on the next 
page.

4.	 Click Cancel to cancel firmware updates.

4
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Once you have clicked OK to update the IPMI Firmware, the Firmware Upload 
screen displays as shown below.

5.	 Enter the name of the firmware you wish to upload. You can also select a 
firmware by clicking the Browse button. 

6.	 Click Upload Firmware and the following screen will display. 

6

5
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7.	 If you would like to keep the current configuration, check the Preserve Con-
figuration checkbox. 

8.	 Click Start Update to begin uploading the selected firmware to the host 
server. 

Warning! To properly update your firmware, do not interrupt the process until the 
process is completed. Once it is completed, the system will automatically reboot, and 
you will need to login to the server again. 

9.	 Click Cancel to abort firmware uploading.  

8 9

7
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2.11.2 Maintenance > Unit Reset
Use this feature to reset the IPMI device. 
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2.11.3 Maintenance > IKVM Reset
This feature allows you to reset iKVM. It will reset virtual media, iKVM keyboard 
and mouse.
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2.11.4 Maintenance > Factory Default
This feature allows the user to restore IPMI to factory default settings. 
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3

2.11.5 Maintenance > IPMI Configuration
This feature allows the user to save IPMI configuration settings. To save the IPMI 
configuration settings, follow the instructions below.

1.	 From the top menu bar, select Maintenance.

2.	 In the Maintenance submenu, select IPMI Configuration.

3.	 Click Save to save the IPMI Configuration settings.

4.	 To reload an IPMI configuration, click the Browse button and select an IPMI 
configuration. 

5.	 Click Reload to reload the IPMI configuration that you seleted.

4
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2.12 	Miscellaneous > POST Snooping

This feature allows the user to perform various network activities including POST 
(Power-On Self-Test) code query and turning-on/-off UID control. To query POST 
codes or to turn on/off UID control, follow the instructions below.

1.	 In the Miscellaneous submenu, select Post Snooping to display the screen 
shown above.

2.	 Click Refresh to query the POST Snooping code for BIOS LPC Port80.

1

2
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2.12.1 Miscellaneous > UID Control
This feature allows the user to turn-on or turn-off UID (Unit Identification) control. 
To turn on or off UID control, follow the instructions below.

1.	 In the Miscellaneous submenu, select UID Control to display the screen 
shown above.

2.	 Select Turn On to turn on UID control.

3.	 Select Turn Off to turn off UID control.

4.	 Click Save to save the setting.

4
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Frequently Asked Questions

3.1	 Frequently Asked Questions

A. Question: How do I flash the IPMI firmware? 

Answer:

Method#1

1.	 In the IPMI menu bar, click Maintenance. Browse the files available and select 
the correct file to flash the firmware. 

2.	 Click the Update Firmware button to proceed with firmware flashing.

Method#2

•	You can flash the IPMI firmware using flash tools located at:
ftp://ftp.supermicro.com/utility/IPMI FW flash tools/. 

•	For the latest IPMI Firmware, please refer to:
http://www.supermicro.com/products/nfo/ipmi.cfm

B. Question: If I am using a firewall for my network connections, which ports 
should I open so that I can access my IPMI connection? 

Answer: In order to access your IPMI connection behind a firewall, please open 
the following ports:

HTTP: 80 (TCP)

HTTPS: 443 (TCP)

IPMI: 623 (UDP)

Remote console: 5900 (TCP)

Virtual media: 623 (TCP)

SMASH: 22 (TCP)

WS-MAN: 8889 (TCP)
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C. Question: When trying to update IPMI firmware through the web, I got a 
file download pop-up, but the firmware was not updated. Why? 

Answer: This may be caused by your anti-virus software. Some anti-virus software 
can cause this. Disable your anti-virus software temporarily and update your 
firmware. 

D. Question: My system seems to function properly; however, the IPMI event log 
indicates that my voltage and temperatures are beyond the limits. Why?

Answer: It is not a normal condition. Make sure that there is no other device 
accessing the I2C bus. If another device accesses the I2C bus frequently, it might 
cause a collision with the BMC when this device accesses the I2C bus. When you 
see this error, please uninstall lm_sensors in the Linux.
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Flash Tools 

A-1 	 Overview

This chapter provides instructions on how to use SMT Flash Tools. The SMT Flash 
Tools Utility supports firmware updates and firmware dumping.

1.	 Firmware Updates

The SMT Flash Tools utility provides a complete solution for firmware updates. The 
user can flash the firmware using DOS, Windows or Linux. In addition, Windows 
and Linux allow the user to update the firmware via LAN or KCS.

2.	 Firmware Dumping

In addition to firmware updating, SMT Flash Tools also support firmware dumping 
from the BMC (Baseboard Management Controller). You can use this feature to 
back up the firmware by dumping the current version of the firmware to an archive 
folder before updating to a new version. It will also allow you to flash other BMCs  
in the factory for mass production. Firmware dumping is supported by DOS, Win-
dows and Linux.

A-2 	 Reference

The SMT Flash Tools Utility was built in reference to the IPMI - Intelligent Platform 
Management Interface Specification Second Generation v2.0, Document Revision 
1.0, February 12, 2004, by Intel, Hewlett-Packard, NEC, and Dell.

A-3 	 Using SMT Flash Tools in the DOS Environment

To use the SMT Flash Tools in DOS, follow the steps below:

1.	 Enter <dupdate.exe> and press <Enter>. 

2.	 The information about the utility will be displayed. Follow the instructions 
given on the screen to configure the settings as shown in Figure 1.
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The main screen of the IPMI Update Utility for DOS (above)  displays the version and 
the built date of the utility currently used in the system. The DOS version of Flash 
Tools Utility allows the user to update or dump the firmware via KCS channels.

Firmware Updating via KCS Channels
To update your firmware via KCS, type <dUpdate.exe –f [filename.bin] –r y.> After 
entering this command, a screen will display as shown in Figure 2. 

1.	 –f: Type <-f> to enter the file name of the firmware that you want to update.

2.	 –r: Type <-r> to preserve the configuration settings you've chosen. This fea-
ture is optional. The default setting is to "preserve" the configuration. 

3.	 y: Type <y> for the BMC to keep all settings after the firmware is updated; 
otherwise, the BMC will reset all settings to factory default.

Figure 1: IPMI Firmware Updates Utility in DOS - Main Screen

After you've entered the commands above, SMT Flash Tools will start to update the 
firmware. There are two phases in firmware updating. 

1.	 Phase 1 is to transfer the FW image file to the BMC. In this phase, Flash 
Tools will transfer three parts to the BMC as shown in Figure 3, Figure 4 and 
Figure 5. 

Figure 2: Examples of Firmware Updates with or without the "Preserved" 
Command

Figure 3: Transferring (Part 0)

Figure 4: Transferring (Part 1)
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2.	 Phase 2 is to flash the new firmware. The progress of firmware updating will 
be displayed as shown in Figure 6. The BMC will reboot after the firmware 
is completely updated. Please wait for the BMC to complete system reboot 
(Figure 7).

Figure 5: Transferring (Part 2)

Figure 6: Progress of Firmware Updating

Figure 7: Updates Completed

Dumping Firmware from the BMC via KCS channels
The user can dump the firmware by typing <dupdate.exe –d [filename].> Flash 
Tools will dump the firmware into the file that the user has assigned in the previous 
command. In the example given in Figure 8, Flash Tools will dump the firmware 
to dump_img.

Figure 8: Example of Firmware Dumping via KCS

There are two phases in firmware dumping. 

1.	 During Phase 1, the Flash Tools Utility is waiting for the BMC to prepare the 
firmware for dumping. As soon as preparation is complete, the Flash Tools Util-
ity will enter Phase 2. 

2.	 In Phase 2, the Flash Tools utility gets the firmware from the BMC. The user 
can see the progress on the screen as shown in Figure 10. 

Figure 9: Phase 1- Flash Tools Waiting for the BMC to Prepare Data
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Figure 10: Flash Tools  Dumping the Firmware

In the Windows/Linux version of the Flash Tools Utility, there are six parameters:

(1)	 –f: Type <-f> to enter the filename of the firmware that you want to update.

(2)	 –i: -i indicates the IPMI channel. Currently, KCS and LAN connections are 
supported. If a LAN connection is used, the user needs to enter the following pa-
rameters:

Figure 11 Main Screen of Flash Tools (in the Windows/Linux Version) 

A-4 	 Windows/Linux Version of Flash Tools 

In addition to DOS, SMT Flash Tools Utility supports Windows and Linux platforms. 

The Windows/Linux version of Flash Tools Utility provides the same features sup-
ported by the DOS version. In addition, it also allows the user to update the firmware 
via LAN connections.

The main screen of the Windows/Linux version displays the information about the 
firmware and the instructions on how to use the utility as shown in Figure 11. 
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1.	 –h: Type <-h> to enter the addresses of the remote BMC and the RMCP+ 
port (default port is 623).

2.	 –u: Type <-u> to enter the IPMI username.

3.	 –p: Type <-p> to enter the password for the IPMI user.

4.	 –r: Type <-r> to preserve (to save) the configuration settings you've entered. 
(This feature is optional.) (Default: preserve configuration.) 

5.	 -y: Type <-y> for the BMC to keep all settings after updating the firmware; 
otherwise, the BMC will reset the settings to factory default.

To connect IPMI via KCS, type <wUpdate.exe/lUpdate –f [filename.bin] –I kcs –r 
y>  as shown in Figure 12.

Figure 12: Example of KCS FW Updates with/without Preserving Configuration

Figure 13: Example of LAN_FW_Updates with/without Preserving Configuration 
and RMCP+ Port

To connect IPMI via LAN, type <wUpdate.exe/lUpdatewUpdate.exe -f [filename.bin] 
-i lan -h 192.168.46.65 623 -u alice -p secret -r y> as shown in Figure 13. 

For other settings, please refer to their counterparts in the DOS version for con-
figuration instructions.
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Introduction to SMASH 

B-1 	 Overview

The SMASH (System Management Architecture for Server Hardware) platform, 
developed by Distributed Management Task Force, Inc. (DMTF), delivers a host of 
architecture-based, industry-standard protocols that will allow IT professionals to 
simplify the task of managing multiple network systems in a data center. SMASH 
offers a simple, intuitive solution to manage heterogeneous servers in a web envi-
ronment regardless of their differences in hardware, software, OS, or network con-
figuration. SMASH provides the end-user and the ISV community with interoperable 
management technology for multi-vendor server platforms.

How SMASH works
SMASH simplifies typical SMASH scripts by reducing commands to simple verbs. 
Although designed to manage multi-servers as a whole, SMASH can address indi-
vidual components in a specific machine by using the SSH command-line protocol. 
Even when multiple processors, add-on cards, logical devices, and cooling systems 
are installed in a server, SMASH can be directed at a particular component in the 
server. A manager can use a text console to access, monitor, and manage all serv-
ers that are connected to the same SSL connection. SMASH can be programmed 
to periodically check all sensors in all machines or monitor a particular component 
in a specific server at any time. By adjusting the scope of tasks and the schedules 
of monitoring, SMASH allows the IT professionals to effectively manage multi-
system clusters, minimize power consumption, and achieve system management 
efficiency.

Figure 1 SMASH-CLP User Interface

Command: 

-> show
1. 2.

User

Transport
Protocol

Server

Transport
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-> 
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SMASH Compliance Information
SMASH documented in this user's guide is developed in reference to and in 
compliance with the SMASH Initiative Standards based on the following DMTF 
documents. 

•	System Management Architecture for Server Hardware (SMASH) Command 
Line Protocol (CLP) Architecture White Paper (DSP 2001)

•	SM CLP Specification (DSP 0214)

•	SM ME Addressing Specifications (DSP 0215)

•	SM SLP to CIM Common Mapping Specification (DSP 0216)

•	Common Information Model (CIM) Infrastructure Specification (DSP0004)

•	The Secure Shell (SSH) Protocol Architecture (RFC4251)

•	The Secure Shell (SSH) Connection Protocol (RFC4254)

B-2 	 An Important Note to the User

The information included in this user's guide provides a general guideline on how 
to use the SMASH protocol for your system management. Instructions given in 
this document may or may not be applicable to your system; it depends on the 
configuration of the system or the environment it operates in.
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B-3 	 Using SMASH

This section provides a general guideline on how to use SMASH for your system 
management in a web-based environment. Refer to the SMASH script provided 
below to curtail a server management protocol for your systems. 

Note: The instructions listed below are applicable to both Windows and 
Linux systems. We use the Windows platform as our default setting.

B-4 	 Initiating the SMASH Protocol

There are two ways of initiating the SMASH protocol.

To Initiate SMASH Automatically
You can initiate SMASH automatically by connecting the BMC (Baseboard Manage-
ment Controller) via the Secure Shell protocol (SSH) from a client machine. 

To connect from a Linux machine
1.	 Use 'ssh<BMC ip address>'.

2.	  Enter the password.

To connect from other machines
1.	 Use a terminal emulator application such as Putty.

2.	 Enter the BMC ip address in the terminal emulator application.

3.	 Choose ssh as the connection type 

4.	 Enter the password at the prompt.

5.	 At the prompt '#", enter <SMASH> to invoke the SMASH prompt '     '.

6.	 If you have successfully logged in, the SMASH prompt will display.
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B-5 	 SMASH-CLP Main Screen

After you've successfully logged in the SSL network, the SMASH Command Line 
Protocol Main screen will display as shown below.

B-6 	 Using SMASH for System Management

After you've familiarized yourself with SMASH commands, you are able to use these 
commands to manage your system. To properly manage your network system, be 
sure to follow the instructions below.

Note:

Make sure that the format of all your commands are compliant with the 
DMTF specification, which is "<Verb> [<option>] [<target>] [<properties>]", 
where: 

•	A Verb means a command.

•	An Option works according to the definition of a command given in Section 
7: Definitions of Command Verbs.

•	A Target is a managed device which is also referred to in the diagram of 
Target Addressing as shown in Figure 2.1.

•	Properties are the specific attributes that you want to assign to a target 
machine or to get from a target machine.

Figure 2 SMASH-CLP Main Screen
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B-7 	 Definitions of Command Verbs

Based on the DSP Specification, each target supports its own set of verbs. These 
verbs allow the user to issue commands to a target system to perform certain tasks. 
For example, the verbs supported by the admin target group include: cd, help, load, 
dump, create, delete, exit, version and show etc. 

•	cd

The command verb cd is used to navigate to a specific target address using the 
SSL protocol. For example, issuing the command cd/admin1 will direct you to the 
target admin (AdminDomain).

•	show

The command verb show is used to display the properties and the contents of a 
target, a group of targets, a sub-groups of the target(s). Properties, contents, sup-
ported operations related to the target, the group of targets or their sub-targets will 
be displayed.

•	exit

The command verb exit is used when you want to exit from a SMASH session or 
close a session. 

•	help

The command verb help is used when you want to get helpful hints or information 
on a context-specific item. This command has the same function as the help option 
listed for the target group.

•	Version

Use the command verb version to display the CLP version used in a specific 
machine.

Figure 3 Using SMASH for System Management
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•	set

Use the command verb set to assign a set of values to the properties of a target 
machine.

•	start

The command verb start is used to turn on the power control, to start a process, or 
to change an operation state from a lower level to a higher level in a system.

•	stop

The command verb stop is used to turn off the power, to stop a process, or to 
change an operation state from a higher level to a lower level.

•	reset

The command verb reset is used to enable or to disable the power control of or 
the processes of the machine.

•	delete

The command verb delete is used to delete or to destroy an entry or a value previ-
ously entered. It can only be used in a specific target as defined according to the 
SAMSHCLP Standards.

•	load

The command verb load is used to move a binary image file from a URI source to 
the MAP. This command will achieve different results depending on the setting of 
a target system, and how the verb load is defined in the DSP specification used  
in the system.

•	dump

The command verb dump is used to move a binary image file from the MAP to a 
URI source. This command will achieve different results depending on the setting 
of a target system, and how the verb dump is defined in the DSP specification 
implemented in the system.

•	create

The command verb create is used to create a new address entry or a new item in 
the MAP. It can only be used in a specific target as defined in the SMASH profile 
or in MAP specifications.
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B-8 	 SMASH Commands

The following table provides the definitions and the descriptions of SMASH com-
mands. The most useful commands are show and help, which will provide the user 
with useful information on how to navigate through the SSL network connection.

Option 
Name

Short 
Form

Definition Notes

-all -a Instructs a command verb to perform 
all tasks possible

None

-destination <URI> None Indicates the final location of an image 
or selected data

URI or SM instance 
address

-display -d Selects data that the user wishes to 
display

This can generate mul-
tiple  query results

-examine -x Instructs the Command Processor 
to examine a command for syntax or 
semantic errors without executing it

None

-force -f Instructs the verb to ignore any warn-
ings triggered by default but go ahead 
executing the command instead

None

-help -h Displays all information and documen-
tation regarding the command verb

None

-keep <m[.s] -k Sets a time period to hold and keep 
the Job ID and the status of a com-
mand

The amount of time set to 
hold a command Job ID 
or its status can differ.

-level <n> -l Instructs the Command Processor to 
execute the command for the current 
target and for all target machines 
within the level specified by the user

Levels should be 
expressed in a nature 
number or "all".

-Output <args> -o Controls the format and the content of 
a command output. This only supports 
"format=clpxml" and "format=keyword"

Many variables or factors 
can affect the outcome of 
format, language, level of 
details of the output.

-Source <URI> None Indicates the location of a source im-
age or a target

URI or SM Instance 
Address

-Version -v Displays the version of the command 
verb

None

-Wait -w Instructs the Command Processor 
to hold the command response or 
query result until all spawned jobs are 
completed.

None

Table 1 SMASH Commands
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B-9 	 Standard Command Options

The following table lists the standard command options.

CLP
Option 

CLP Verbs

all x

destination x

display x

examine x x x x x x x x x x x x x

force x x x x x x x x

help x x x x x x x x x x x x x

keep 

level x

Output x x x x x x x x x x x x x

Source x

Version x x x x x x x x x x x x x

Wait

Table 2 Standard Command Options

C
D

C
re

at
e

de
le

te

du
m

p

ex
it

he
lp

lo
ad

re
se

t

se
t

sh
ow

st
ar

t

St
op

ve
rs

io
n



Appendix B: Using SMASH

B-9

/

system1

pwrmgtsvc1 logs1 sensors1

log1

record001

record002

recordxxx

.

.

.

.

.

sensor001

sensor002

.

.

.

.

.

sensorxxx

B-10 	Target Addressing

To simplified the process of SMASH command execution, a file system called Target 
Addressing was created as shown in the diagram below.

Figure 4 Target Addressing Diagram

Terms Used in the Target Addressing Diagram
This section provides the descriptions of the terms used in the Target Addressing 
Diagram above.

•	"/" indicates the root of the system.

•	"/system1" includes all major Targets.

•	"/system1/logs1/log1" includes all senor event logs.

•	"/system1/sensors1" contains the readings and information of all sensors.

•	"/system1/pwrmgtsvc1" is used for chassis control.

•	"show../logs1" allows you to issue SMASH commands for the system to per-
form the tasks of your choice. For example:

•	Issuing the command "show/system1/logs1" while you are in "show../
logs1" will allow you to set the Absolute or the Relative target path.
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 Appendix C  
 

RADIUS Setup Guidelines

This chapter provides the Radius setup guidelines for IPMI firmware. 

1.	 Start VM with RHEL4.7.VMX and boot into the OS.

2.	 Check the IP address of the RADIUS server.

 3.	 Configure User information.

# vi /etc/raddb/users

•	H=4, I =4     Administrator (Super)

•	H=3, I =3  Operator (Randy)

•	H=2, I =2  User (Tester)

•	H=1, I =1  No Access
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4.	 Configure Client information.

# vi /etc/raddb/client.conf

 5.	 Configure Port information.

# vi /etc/raddb/radiusd.conf

6.	 Start RADIUS service.

7. Enable RADIUS in the IPMI web page.
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8.	 Logout ADMIN and try to login using a RADIUS account
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Notes



(Disclaimer Continued)

The products sold by Supermicro are not intended for and will not be used in life support systems, medical equipment, nuclear facilities or systems, aircraft, aircraft devices, 
aircraft/emergency communication devices or other critical systems whose failure to perform be reasonably expected to result in significant injury or loss of life or catastrophic 
property damage. Accordingly, Supermicro disclaims any and all liability, and should buyer use or sell such products for use in such ultra-hazardous applications, it does so 
entirely at its own risk. Furthermore, buyer agrees to fully indemnify, defend and hold Supermicro harmless for and against any and all claims, demands, actions, litigation, and 
proceedings of any kind arising out of or related to such ultra-hazardous use or sale.


